
 Add2Exchange Quick Start Guide 

© 2019 Advantage International Inc. / DidItBetter Software. All rights reserved 1 | P a g e  
 

Table of Contents 
Guide for On-Premise Exchange & Office 365  Add2Exchange Enterprise/365 Editions .................................. 4 

Sync Overview and Best Practices ............................................................................................................................... 4 

Installation Guide ........................................................................................................................................................... 4 

Administration Guide .................................................................................................................................................... 4 

Troubleshooting Resources .......................................................................................................................................... 4 

Print Version ................................................................................................................................................................... 4 

Important ......................................................................................................................................................................... 4 

Support Tip ................................................................................................................................................................. 4 

Rights Information ......................................................................................................................................................... 4 

Support Note .................................................................................................................................................................. 5 

Third Party Software ...................................................................................................................................................... 6 

Your Rights as a Licensee ............................................................................................................................................. 6 

Seamless Synchronization .................................................................................................................................................. 7 

Public Folder & Mailbox Synchronization ................................................................................................................. 7 

Relationships ................................................................................................................................................................... 7 

Relationships Between Pairs of Folders ..................................................................................................................... 8 

Pre-Requisites Prior to Installation .................................................................................................................................. 9 

Recommended Min. Specs for your Appliance .................................................................................................... 9 

Logging into your appliance for the first time ...................................................................................................... 9 

Quick Notes ....................................................................................................................................................................... 10 

Exchange 2010 Setup and Configuration ..................................................................................................................... 11 

Creating a new Service Account ................................................................................................................................ 11 

Mailbox Creation Exchange 2010.............................................................................................................................. 13 

Pre-Requisites Prior to Installation............................................................................................................................ 16 

Recommended min. Specs for your appliance .................................................................................................... 16 

Logging into your appliance for the first time .................................................................................................... 16 

PowerShell How to ...................................................................................................................................................... 17 

PowerShell Upgrade ................................................................................................................................................ 18 

Setting up the Execution Policy ................................................................................................................................. 19 

Outlook Setup ............................................................................................................................................................... 20 

Installing Add2Exchange ............................................................................................................................................ 27 

Adding Permissions ..................................................................................................................................................... 33 

Exchange 2013-2016 Setup and Configuration ........................................................................................................... 36 



 Add2Exchange Quick Start Guide 

© 2019 Advantage International Inc. / DidItBetter Software. All rights reserved 2 | P a g e  
 

Creating a new Service Account ................................................................................................................................ 36 

Mailbox Creation Exchange 2013-2016.................................................................................................................... 38 

Pre-Requisites prior to Installation ............................................................................................................................ 39 

Recommended Min. Specs for your Appliance .................................................................................................. 39 

Logging into your appliance for the first time .................................................................................................... 39 

PowerShell How to ...................................................................................................................................................... 40 

PowerShell Upgrade ................................................................................................................................................ 41 

Setting up the Execution Policy ................................................................................................................................. 42 

Outlook Setup ............................................................................................................................................................... 43 

Installing Add2Exchange ............................................................................................................................................ 50 

Adding Permissions ..................................................................................................................................................... 56 

Office 365 Setup and Configuration for Add2Exchange 365 Edition..................................................................... 59 

Creating a New Service Account in a Hybrid Environment ................................................................................. 59 

Directory Synchronization - Office 365 ................................................................................................................... 61 

Pre-Requisites prior to Installation ............................................................................................................................ 62 

Recommended Min. Specs for Your Appliance ................................................................................................. 62 

Logging into your appliance for the first time .................................................................................................... 62 

PowerShell How to ...................................................................................................................................................... 63 

PowerShell Upgrade ................................................................................................................................................ 64 

Setting up the Execution Policy ................................................................................................................................. 65 

Outlook Setup ............................................................................................................................................................... 66 

Installing Add2Exchange ............................................................................................................................................ 74 

Adding Permissions ..................................................................................................................................................... 80 

Guided Installation Pre-Requisites ................................................................................................................................. 83 

Recommended Min. Specs for your Appliance .................................................................................................. 83 

Logging into your appliance for the first time .................................................................................................... 83 

Setting up the Execution Policy ................................................................................................................................. 84 

Outlook Setup Guided ................................................................................................................................................ 96 

Wrap-Up Notes Post Installation ................................................................................................................................. 101 

Add2Exchange Console Overview .............................................................................................................................. 102 

Help .............................................................................................................................................................................. 103 

License.......................................................................................................................................................................... 103 

Service and Utility....................................................................................................................................................... 104 

Process Interval ...................................................................................................................................................... 104 

Application Logging .............................................................................................................................................. 105 



 Add2Exchange Quick Start Guide 

© 2019 Advantage International Inc. / DidItBetter Software. All rights reserved 3 | P a g e  
 

Application Performance ...................................................................................................................................... 105 

Status of Required Services .................................................................................................................................. 106 

Load Users .............................................................................................................................................................. 106 

Tools ............................................................................................................................................................................. 107 

Global Options ...................................................................................................................................................... 107 

Backups ................................................................................................................................................................... 108 

Look and Feel ......................................................................................................................................................... 108 

Empty Trash ........................................................................................................................................................... 109 

GAL Sync Options ................................................................................................................................................ 109 

GAL Exclusions ..................................................................................................................................................... 110 

Relationship ................................................................................................................................................................. 110 

Relationship Group Manager ................................................................................................................................... 111 

Creating Single (1 to 1) Relationships Source to Destination .................................................................................. 112 

One-Way & Two-Way Relationship Creation ....................................................................................................... 112 

Creating a Full-Mesh .................................................................................................................................................. 119 

Deleting Relationships ............................................................................................................................................... 121 

Relationship Template Creation with Relationship Group Manager ..................................................................... 124 

2-Way Sync (Bi-Directional Template) ................................................................................................................... 133 

Full-Mesh Sync with Relationship Group Manager ............................................................................................. 135 

Attaching a Distribution List to Templates ........................................................................................................... 139 

Global Address List Syncing ......................................................................................................................................... 142 

Attaching the GAL Template to a Distribution List ............................................................................................ 150 

Deleting Add2Exchange Templates ............................................................................................................................ 154 

Syncing Add2Exchange ................................................................................................................................................. 157 

Sync Tip ................................................................................................................................................................... 160 

Licensing Add2Exchange .............................................................................................................................................. 163 

Upgrading Add2Exchange ............................................................................................................................................ 166 

Migrating Add2Exchange .............................................................................................................................................. 171 

Migrating Add2Exchange Appliance only ............................................................................................................. 171 

Migrating Exchange Environments and Office 365 ............................................................................................. 173 

Troubleshooting Tips ..................................................................................................................................................... 175 

 

  



 Add2Exchange Quick Start Guide 

© 2019 Advantage International Inc. / DidItBetter Software. All rights reserved 4 | P a g e  
 

Guide for On-Premise Exchange & Office 365  

Add2Exchange Enterprise/365 Editions 
Free 21 day, fully functional version available for download at: 

https://www.diditbetter.com/ 

Manual updates as of January 28, 2019 

Sync Overview and Best Practices 
A guide written from the perspective of the end-user of Add2Exchange. An excellent beginner's guide for 

end-user and administrator alike. Start here. 

Installation Guide  
A straightforward guide to installing Add2Exchange. Does not cover background material necessary to plan 

your configuration once the software is installed, so be sure to read the Administration Guide prior to this 

guide. 

Administration Guide 
A guide for the administrator of Add2Exchange. Covers sync concepts in more depth, deployment planning, 

and implementation. 

Troubleshooting Resources 
Resources from DidItBetter.com to assist with any technical installation questions you encounter. 

Print Version 
A PDF version of the most current revision of this manual is available HERE 

Important 
Please read the Release Notes included with the version of Add2Exchange you are installing regardless of 

whether you are new to Add2Exchange or an experienced user. 

The Release Notes summarize important updates on the installation process, any changes to capabilities, 

including enhancements and retractions, user changes in behavior, configuration changes, system 

requirements and procedures. This information is significant and will ensure proper operation. 

Support Tip 

Save time! Want to skip reading this manual? We offer Remote Installation and Configuration Services for 

this software. Visit SUPPORT for pricing and to purchase your Remote Installation Service today! 

Rights Information 
Microsoft®, Windows®, Windows Server®, Exchange®, Exchange Server®, Outlook®, Outlook Web 

Access®, SQL Server®, SQL Server Express®, Microsoft Update®, PowerShell®, Remote Desktop 

Connection®, SkyKick®, MigrationWiz®, are the registered property of their respective owners. 

 

DidItBetter Software®, DidItBetter®, Add2Exchange®, Add2Exchange 365® Add2Exchange Enterprise®, 

Add2Outlook®, GAL Sync Manager®, Relationship Group Manager®, and all DidItBetter products 

including modules, add-ons are the registered property of DidItBetter Software. 

The End User License Agreement (EULA) for this product is available HERE 

 

https://www.diditbetter.com/
http://support.diditbetter.com/guides.aspx
http://support.diditbetter.com/premium-support.aspx
http://guides.diditbetter.com/Add2Exchange_EULA.pdf
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Support Note 
Let's start by building a good relationship between you and our Support team. Before installing, it is a good 

idea to read this document in its entirety because, as with any powerful tool, it is best to be familiar with ALL 

of the practical aspects of Add2Exchange operations before using it on your mission-critical data. 

Install the solution after having read through this manual, as there are some prerequisites you have to 

complete to have a successful trial run. As good advice, back up your data FIRST, before installation and 

operation. 

If you have a problem, you can reference Self Help Technical Topics and Frequently Asked Questions on our 

Support website HERE 

Search the online knowledgebase anytime to help you find almost every issue the Support team has 

encountered, complete with recommendations and resolutions. You can also open a ticket for email support 

HERE or initiate live chat support when we’re online. 

 

Thanks for helping us build a great support relationship. 

The DidItBetter Software Team 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://support.diditbetter.com/knowledgebase.aspx
http://support.diditbetter.com/support-request.aspx
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Third Party Software 
If you have any external programs which operate on a source or destination folder involved in an 

Add2Exchange relationship, make these programs known to your support personnel. 

If you are using any third-party software such as an ERP solution to update the Global Address List or Active 

Directory objects, for example, and plan to use Add2Exchange for Global Address List syncing, make this 

known to one of our technical consultants so we can best advise you. 

If you are using Prolaw, there are some special considerations discussed on the Support site to help integrate 

this solution into your environment correctly. Communicating this information to us in advance can help you 

avoid potential delays in successful synchronization and can assist in setting up the Rules of the Information 

Relationships correctly for your environment. 

At this point in the software development cycle, there are no known incompatibilities with these and other 

solutions reported to date; however, you may need to make special considerations to make it work optimally. 

 

Your Rights as a Licensee 
1. You have the right to a better user experience by reading this manual. Informed customers make 

their own experience better. 

2. Licensed users have the right to FREE basic email support on the licensed solution and access to 

updates and upgrades on the licensed product available for download from the web for the duration 

of your software assurance term. Our online Technical Support Knowledge Base is also absolutely 

FREE and can be found HERE 

3. You have the right to phone or remote support for a reasonable fee. These Premier Support sessions 

are held by appointment weekdays between 9 a.m. and 5 p.m. ET, excluding holidays. Visit: HERE 

for more info on DidItBetter Professional Services and available plans. 

4. You have the right to escalate your case to Priority Support for an additional fee. Priority Support 

cases are handled ahead of other cases and, at the discretion of DidItBetter Software, may be handled 

outside of regular business hours. 

5. You have the right to have your configuration certified, the package installed, upgraded and/or 

configured for you for a reasonable fee by one of our certified DidItBetter Software technicians. 

6. You have the right to have your ideas and suggestions be heard, acknowledged and considered for 

future upgrades. 

7. You have the right to have your feature request escalated to a formally quoted development request. 

You may open a support ticket HERE. 

USA/Canada: 813 977 5739 | International: 001 813 977 5739. 

 

 

Thank you for the opportunity to be of service. We look forward to working with you. 

 

 

 

 

http://support.diditbetter.com/knowledgebase.aspx
http://support.diditbetter.com/premium-support.aspx
http://support.diditbetter.com/support-request.aspx
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Seamless Synchronization 
For synchronization to occur, there is nothing you, the user, do to initiate it. No buttons to push, no progress 

dialogs to wait for. It just happens automatically; however, because of the power of synchronization, some 

user habits can have unintended consequences. You may not want to synchronize that fifty-megabyte 

attachment to a hundred other users, but that's exactly what you may unintentionally do if you're not careful! 

It is important to read the Best Practices section so you know what to do and what not to do in synchronized 

folders. 

There are also a few details to know about how synchronization works which will help it make sense when 

unexpected changes happen. Please read the following sections to become familiar with the basic operation of 

Add2Exchange, what features are available and your options for how synchronization behavior may be 

configured. 

Public Folder & Mailbox Synchronization 
Add2Exchange synchronizes items between folders within the same organization. Synchronization may be 

performed between any combination of public and mailbox folders (also referred to as Private or Personal 

folders), provided the folders contain items of the same type (calendar appointments, contacts, tasks). 

Because Add2Exchange distinguishes between the source (the folder new items are created in) and 

destination folders (the folder you want the items to sync/replace to), this means you may build relationships 

in any of four combinations: 

• Public folder to Private folder 

• Private folder to Public folder 

• Private folder to Private folder 

• Public folder to Public folder 

 

Relationships 
Synchronization with Add2Exchange is founded on the concept of a relationship between a source and a 

destination folder. A relationship brings the contents of one folder to another, the contents of the source to 

the destination. 

Note: a relationship does not bring the contents of the destination folder to the source folder. While you may 

define another corresponding relationship which does so, when you are looking at any particular relationship, 

that relationship is only responsible for synchronizing the contents of its source to its destination. 

There are various kinds of relationships, with configurable options for behavior. The most important thing to 

understand, however, is that there is one relationship for each pair of source and destination folders. This 

means, for example, if you have a single public source folder which you want to synchronize to several users, 

you will need to create one relationship from the public folder (the source) to each of the user's folders (the 

destinations). 
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Relationships Between Pairs of Folders 
There are three general synchronization behaviors for a pair of folders. These are controlled by the specific 

settings employed by your administrator. Consult your administrator for the details of your relationship type. 

The three types are: 

• One-Way Synchronization: Items from the source folder are synchronized to the destination but 

changes to copies cannot affect originals in the source. 

• Two-Way Synchronization: Items from the source folder are synchronized to the destination and 

changes to copies can affect originals in the source. 

• Full-Mesh Synchronization: Items from each folder are synchronized to the other folder. All folders 

end up with an equivalent set of items. Each relationship may be configured separately, but by 

convention usually have the same settings. 
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Pre-Requisites Prior to Installation 
Overview of your sync appliance: 

We can install Add2Exchange on the current Operating Systems below: 

Windows Server Windows 

Server 2008 R2 x64 
Server 2012 x64 
Server 2012 R2 x64 
Server 2016 x64 
Server 2019 x64 
 

Windows 7 x64 
Windows 8.1 x64 
Windows 10 x64 

 

Recommended Min. Specs for your Appliance 

• 1 Processor – (2 Cores) 

• 4-8GB RAM 

• 80GB minimum Hard Drive space 

• Outlook 2016 or Outlook 365 32Bit (Only)* 

• UAC (User Access Control) Must be disabled from the registry. (Reboot after disabling) 

In the unpacked folder for Add2Exchange is a folder called Setup. Open that folder and locate a file 

called “Disable_UAC” If you run this file (Right click, run with PowerShell) it will disable UAC for 

you.  

• All Microsoft Updates 

• PowerShell ver. 5.1 (You must update PowerShell on both your Exchange server and Appliance) 

Logging into your appliance for the first time 

*Ensure that your new sync service account is a Local Admin of your appliance before logging on 
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Quick Notes 
• Exchange Servers Supported: 

Exchange 2016, 2013, 2010, 2007, 2003 & Office 365 

• Do not perform a new installation of Add2Exchange under *any* pre-existing account.  (Upgrades 

under the existing account are fine, of course). Add2Exchange requires its own, separate account. 

Make a new account such as Zadd2Exchange 

For example, do not install Add2Exchange under the domain administrator account 

• Before install, Disable UAC on the Replication Server within the registry not the Interface. 

Manually disabling UAC through the registry: 

Open regedit 

o   Go to Start, Run 

o   At the common prompt type regedit and press Enter to open the Registry Editor 

o   Drill down to the System folder found under 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policie

s\System\ 

o   When you click on the System folder, on the right-hand side you will see a key for EnableLUA 

o   Double click to open the Edit DWORD Value window. Under value data: change from 1 to 0  

Click OK  

Close regedit and reboot 

  

• Do all Microsoft critical updates, including all Microsoft programs. Reboot and check for updates 

again. 

• Make sure to put the power options on the replication appliance to full performance.  

• Add2Exchange should not be installed on the Exchange server. It is highly recommended that it is 

installed on its own VM or appliance. 

• Ensure that Auto Discover is properly setup and working  

• To create a ticket follow this link: Open a Ticket Online to Submit a Support Request or for trial 

users who need to schedule a Proof of Concept guided certified installation, Buy a Proof of Concept 

Trial Install Session 

  

http://support.diditbetter.com/support-request.aspx
https://www.diditbetter.com/shop/poc-trial-install
https://www.diditbetter.com/shop/poc-trial-install
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Exchange 2010 Setup and Configuration 

Creating a new Service Account 
Create the Sync service account in Active Directory. 

 

Call the user zAdd2Exchange to drop it to bottom of Global Address List since this account CANNOT be 

hidden from the GAL.  

 

Set the account password to never expire 
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Click Finish. 

 

Notice the account memberships will remain as Domain User 

(nothing else is needed) 
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Mailbox Creation Exchange 2010 
Now it’s time to give the user a mailbox 

Go into Exchange Management console: 

 

Create a new user mailbox: 

 

Click Existing user and choose the new service account you just created: 
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Hit Next. 

In Mailbox settings you want to keep the Alias name the same and specify the mailbox database. 

In this case, we will choose the default setting and auto select: 

 

Once done, Hit Next 

Hit New to Create your new mailbox: 
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Once done hit Finish: 

 

User and mailbox Creation are now finished. You may proceed to below. 
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Pre-Requisites Prior to Installation 
Overview of your sync appliance: 

We can install Add2Exchange on the current Operating Systems below: 

Windows Server Windows 

Server 2008 R2 x64 
Server 2012 x64 
Server 2012 R2 x64 
Server 2016 x64 
Server 2019 x64 
 

Windows 7 x64 
Windows 8.1 x64 
Windows 10 x64 

 

Recommended min. Specs for your appliance 

• 1 Processor – (2 Cores) 

• 4-8GB RAM 

• 80GB minimum Hard Drive space 

• Outlook 2016 or Outlook 365 32Bit (Only)* 

• UAC (User Access Control) Must be disabled from the registry. (Reboot after disabling) 

In the unpacked folder for Add2Exchange is a folder called Setup. Open that folder and locate a file 

called “Disable_UAC” If you run this file (Right click, run with PowerShell) it will disable UAC for 

you.  

• All Microsoft Updates 

• PowerShell ver. 5.1 (You must update PowerShell on both your Exchange server and Appliance) 

Logging into your appliance for the first time 

*Ensure that your new sync service account is a Local Admin of your appliance before logging on 
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PowerShell How to 
Before we continue, we have to make sure PowerShell is up to date on both your Exchange Server and your 

appliance. For users on Server 2016, Server 2019, or Windows 10, you will not have to perform the tasks 

below as PowerShell is up to date out of the box. 

On your appliance and/or your Exchange Server, open PowerShell as an Administrator: 

 

To figure out what version of PowerShell you are on: 

With the PowerShell window open type: Get-Host 

 

Hit Enter 

You should see the Version number of PowerShell. In this case we already have version 5.1. 

 

If you do not have the latest version (5.1), please update via Microsoft Updates and reboot. 
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PowerShell Upgrade  

Note* For convenience, if you have already downloaded Add2Exchange and unpacked the self-extracting 

executable; you will find a folder called “Setup” 

 

Open that folder and locate a PowerShell file called “Legacy_PowerShell” 

 

Right click the file and Run with PowerShell: 

 

This will automatically take you through updating the PowerShell version on your appliance and Exchange 

Server.  

Note* Upgrading PowerShell will require a reboot. Please plan accordingly. 
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Setting up the Execution Policy 

We must now set the execution policy in PowerShell to remote signed on your appliance. 

Open PowerShell as an Administrator 

Type: Set-Executionpolicy -scope localmachine -executionpolicy remotesigned 

Press Enter 

 

Type “A” for Yes to All and click Enter 

PowerShell is now set with the proper execution policy and can exit the window. 
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Outlook Setup 
To begin with installation on your appliance we must first setup your Outlook profile: 

Note* Outlook must be the 32bit version of either Outlook 2016 or Outlook 365 

Go to your Control Panel and double click on the Mail Icon. 

 

Create a new Profile by clicking the Add button: 

 

Note* You can name the new profile anything here, but is recommended that you name the profile the email 

address of your new service account: 

 
 

Click OK when finished 
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On the next screen, click next  

 

On the next screen you want to make sure that check the box “Change account settings” and click Next: 

 

Make sure to uncheck “Use Cached Exchange Mode” on the next screen. When done, click Finish.  

Note* This new profile cannot be cached. 
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Click OK to finish the profile setup: 

 

Open Outlook: 

 

Once Outlook opens click on File>Options 
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Click on Add-ins and then the “Go…” button 

 

Note* In this next window it is extremely important to uncheck the Outlook Social Connector 

 

Click OK and go back into File>Options>Trust Center>Trust Center Settings 

 

In the next series of windows, we will check or uncheck certain features within outlook. We will begin with 

Programmatic Access and work our way up. Below are screen shots of how this should all look. 
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Once done, click OK and OK again.  

Next, Click on Address Book 

 

When the Address Book opens, click on Tools>Options 

In this window, check custom and select Global Address List in the drop-down menu: 

 

When finished, click ok and exit out of Address Book. 

The last step to do is Define Send/Receive Groups: 
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Uncheck both “Include this group in Send/Receive” and check “Perform an automatic send/receive when 

exiting: 

 

When done, click close and File>Exit out of Outlook. 
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Installing Add2Exchange 
With the Add2Exchange download unpacked; locate the Add2Exchange.msi. Right click>Install 

 
 

Click Next 

Click “I Agree” and Next 
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Click Next on the next 2 screens: 

 

 

Choose the installation path and click next.  

Note* We recommend defaults 
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Click Next when ready to continue: 

 

 

Enter your sync service account credentials when prompted and click OK: 
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On the next screen you will want to click on “Install Locally” This will install SQL express on your appliance 

for the Add2Exchange database. Click Yes to complete. 

 

On the next screen; click on “Create New A2ESQLServer” 

 

This next screen should automatically pick the Outlook Profile we created earlier. If no profile is visible, you 

can type it in manually below and click Accept: 
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Enter your sync service account credentials again and click OK: 

 

Once finished, click Close: 

 
 

On your desktop there will be a new icon called Add2Exchange Console. Double click it to open and start 

the silent SQL install. This process will take a few moments: 
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Once the install is finished you will be prompted stating that the database has been created successfully. Click 

OK, and the Add2Exchange console will now open.  
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Adding Permissions 
The last step is to add Permissions to the users we will be syncing with before you start to make relationships 

to them. Locate the directory were you downloaded and unpacked Add2Exchange. Open the Setup folder 

and locate the file called” PermissionsOnPremOrO365Combined” 

Right click the file and run with PowerShell: 

 

If you get an Execution Policy change prompt, select A for Yes to All and press Enter. 

  

In the next screen you will choose your environment. In this case we will type M for Exchange 2010. Hit 

Enter to continue 

 

The next question will ask you if you are on the Exchange server. In this case, we are running this directly on 

the sync appliance. Type N and hit Enter. 

 

A pop up will come up if you type in N. This explains how to turn on PS Remoting. Click OK to continue. 
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The next prompt will ask you for your Exchange server name. If running in a clustered or CAS environment, 

just type in the name of a single mailbox server and click Enter. This will pull in and load exchange PS 

Remoting locally to this box. 

 

Login as an Administrator to your Exchange server. If login is successful, you will be prompted next to enter 

the Sync Service Account name (Display name) and hit Enter. 

 

On the next screen you will have the option to give full access permissions to everyone, to a distribution list, 

or to just a single user. In this instance we will choose option 0 to add permissions to everyone. 

Note* This will also automatically add the Add2Exchange throttling policy for the sync service account. 
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The last prompt will ask if you want to add permissions to public folders.  

 

If you are trying to sync public folders, then type in Y and click Enter to continue. Follow the onscreen 

prompts until it prompts you for the Public Folder Name you want to use. At that point you can enter in the 

name of the public folders you need to give permissions to: 

 

Type in the name and click Enter. When finished, click N to not run this again. You are finished!!! You can 

now create relationships and start syncing with Add2Exchange. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 Add2Exchange Quick Start Guide 

© 2019 Advantage International Inc. / DidItBetter Software. All rights reserved 36 | P a g e  
 

Exchange 2013-2016 Setup and Configuration 

Creating a new Service Account 
Create the Sync service account in Active Directory 

 

Call the user zAdd2Exchange to drop it to bottom of Global Address List since this account CANNOT be 

hidden from the GAL.  

 

Set the account password to never expire 
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Click Finish 

 

Notice the account memberships will remain as Domain User 

(nothing else is needed) 
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Mailbox Creation Exchange 2013-2016 
Now it’s time to give the user a mailbox 

Go into Exchange Admin Center and create a new user mailbox: 

 
 

Ensure that the Alias name is the same as the sync service account you just created and browse for existing 

users: 

 
 

When finished, click Save. 
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Pre-Requisites prior to Installation 

 
Overview of your sync appliance 

We can install Add2Exchange on the current Operating Systems below: 

Windows Server Windows 

Server 2008 R2 x64 
Server 2012 x64 
Server 2012 R2 x64 
Server 2016 x64 
Server 2019 x64 
 

Windows 7 x64 
Windows 8.1 x64 
Windows 10 x64 

 

Recommended Min. Specs for your Appliance 

• 1 Processor – (2 Cores) 

• 4-8GB Ram 

• 80GB minimum Hard Drive space 

• Outlook 2016 or Outlook 365 32Bit (Only)* 

• UAC (User Access Control) Must be disabled from the registry. (Reboot after disabling) 

In the unpacked folder for Add2Exchange is a folder called Setup. Open that folder and locate a file 

called “Disable_UAC” If you run this file (Right click, run with PowerShell) it will disable UAC for 

you.  

• All Microsoft Updates 

• PowerShell ver. 5.1 (You must update PowerShell on both your Exchange server and Appliance) 

Logging into your appliance for the first time 

*Ensure that your new sync service account is a Local Admin of your appliance before logging on 
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PowerShell How to 
Before we continue, we have to make sure PowerShell is up to date on both your Exchange Server and your 

appliance. For users on Server 2016, Server 2019, or Windows 10, you will not have to perform the tasks 

below as PowerShell is up to date out of the box. 

On your appliance and/or your Exchange Server, open PowerShell as an Administrator: 

 

To figure out what version of PowerShell you are on: 

With the PowerShell window open type: Get-Host 

 

Hit Enter 

You should see the Version number of PowerShell. In this case we already have version 5.1. 

 

If you do not have the latest version (5.1), please update via Microsoft Updates and reboot. 
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PowerShell Upgrade 

Note* For convenience, if you have already downloaded Add2Exchange and unpacked the self-extracting 

executable; you will find a folder called “Setup” 

 

Open that folder and locate a PowerShell file called “Legacy_PowerShell” 

 

Right click the file and Run with PowerShell: 

 

This will automatically take you through updating the PowerShell version on your appliance and Exchange 

Server.  

Note* Upgrading PowerShell will require a reboot. Please plan accordingly. 
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Setting up the Execution Policy 
We must now set the execution policy in PowerShell to remote signed on your appliance. 

Open PowerShell as an Administrator 

Type: Set-Executionpolicy -scope localmachine -executionpolicy remotesigned 

Press Enter 

 

Type “A” for Yes to All and click Enter 

PowerShell is now set with the proper execution policy and can exit the window. 
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Outlook Setup 
To begin with installation on your appliance we must first setup your Outlook profile: 

Note* Outlook must be the 32bit version of either Outlook 2016 or Outlook 365. 

Go to your Control Panel and double click on the Mail Icon. 

 

Create a new Profile by clicking the Add button. 

 

Note* You can name the new profile anything here, but is recommended that you name the profile the email 

address of your new service account: 

 
 

Click OK when finished. 
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On the next screen, click Next. 

 

On the next screen you want to make sure that check the box “Change account settings” and click Next. 

 

Make sure to uncheck “Use Cached Exchange Mode” on the next screen. When done, click Finish.  

Note* This new profile cannot be cached. 
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Click OK to finish the profile setup: 

 

Open Outlook: 

 

Once Outlook opens click on File>Options. 
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Click on Add-ins and then the “Go…” button. 

 

Note* In this next window it is extremely important to uncheck the Outlook Social Connector. 

 

Click OK and go back into File>Options>Trust Center>Trust Center Settings. 

 

In the next series of windows, we will check or uncheck certain features within Outlook. We will begin with 

Programmatic Access and work our way up. Below are screen shots of how this should all look. 
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 Add2Exchange Quick Start Guide 

© 2019 Advantage International Inc. / DidItBetter Software. All rights reserved 48 | P a g e  
 

Once done, click OK and OK again.  

Next, click on Address Book. 

 

When the Address Book opens, click on Tools>Options. 

In this window, check custom and select Global Address List in the drop-down menu: 

 

When finished, click ok and exit out of Address Book. 

The last step to do is Define Send/Receive Groups: 
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Uncheck both “Include this group in Send/Receive” and check “Perform an automatic send/receive when 

exiting: 

 

When done, click close and File>Exit out of Outlook. 
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Installing Add2Exchange 
With the Add2Exchange download unpacked; locate the Add2Exchange.msi. Right click>Install 

 
 

Click Next. 

Click “I Agree” and Next. 
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Click Next on the next 2 screens: 

 

 

Choose the installation path and click Next.  

Note* We recommend defaults. 
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Click Next when ready to continue: 

 

 

Enter your sync service account credentials when prompted and click OK: 
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On the next screen you will want to click on “Install Locally” This will install SQL express on your appliance 

for the Add2Exchange database. Click Yes to complete. 

 

On the next screen; click on “Create New A2ESQLServer” 

 

This next screen should automatically pick the Outlook Profile we created earlier. If no profile is visible, you 

can type it in manually below and click Accept: 
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Enter your sync service account credentials again and click OK. 

 

Once finished, click Close. 

 
 

On your desktop there will be a new icon called Add2Exchange Console. Double click it to open and start 

the silent SQL install. This process will take a few moments: 
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Once the install is finished you will be prompted stating that the database has been created successfully. Click 

OK, and the Add2Exchange console will now open.  
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Adding Permissions 
The last step is to add Permissions to the users we will be syncing with before you start to make relationships 

to them. Locate the directory where you downloaded and unpacked Add2Exchange. Open the Setup folder 

and locate the file called” PermissionsOnPremOrO365Combined” 

Right click the file and run with PowerShell: 

 

If you get an Execution Policy change prompt, select A for Yes to All and press Enter. 

  

In the next screen you will choose your environment. In this case we will type E for Exchange 2013-2016. Hit 

Enter to continue. 

 

The next question will ask you if you are on the Exchange server. In this case, we are running this directly on 

the sync appliance. Type N and hit Enter. 

 

A pop up will come up if you type in N. This explains how to turn on PS Remoting. Click OK to continue. 
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The next prompt will ask you for your Exchange server name. If running in a clustered or CAS environment, 

just type in the name of a single mailbox server and click Enter. This will pull in and load exchange PS 

Remoting locally to this box. 

 

Login as an Administrator to your Exchange server. If login is successful, you will be prompted next to enter 

the Sync Service Account name (Display name) and hit Enter. 

 

On the next screen you will have the option to give full access permissions to everyone, to a distribution list, 

or to just a single user. In this instance we will choose option 0 to add permissions to everyone. 

Note* This will also automatically add the Add2Exchange throttling policy for the sync service account. 
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The last prompt will ask if you want to add permissions to public folders.  

 

If you are trying to sync public folders, then type in Y and click Enter to continue. Follow the onscreen 

prompts until it prompts you for the Public Folder Name you want to use. At that point you can enter in the 

name of the public folders you need to give permissions to: 

 

Type in the name and click Enter. When finished, click N to not run this again. You are finished!!! You can 

now create relationships and start syncing with Add2Exchange. 
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Office 365 Setup and Configuration 

for Add2Exchange 365 Edition 

 
Note* For users completely on Office 365 (not in a hybrid environment) create a new user in Office 365 as 

your tenant admin. The new user must have a mailbox and an E1-E3 License attached to it. Once done, you 

can skip to “Pre-Requisites prior to installation” 

Creating a New Service Account in a Hybrid Environment 
Create the Sync service account in Active Directory. 

 

Call the user zAdd2Exchange to drop it to bottom of GAL since this account CANNOT be hidden from the 

Global Address List.  

 

Set the account password to never expire. 
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Click Finish. 

 

Notice the account memberships will remain as Domain User 

(nothing else is needed) 
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Directory Synchronization - Office 365 
With the new account created, run Dir sync to get the account synchronized with Office 365.  

Note* The new user must have a mailbox and an E1-E3 License attached to it. 

Once finished, ensure you can open the mailbox via OWA to allow the new mailbox to initialize. Once 

completed, we can now move on to Pre-requisites prior to installation. 
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Pre-Requisites prior to Installation 
Overview of your sync appliance 

We can install Add2Exchange on the current Operating Systems below: 

Windows Server Windows 

Server 2008 R2 x64 
Server 2012 x64 
Server 2012 R2 x64 
Server 2016 x64 
Server 2019 x64 
 

Windows 7 x64 
Windows 8.1 x64 
Windows 10 x64 

 

Recommended Min. Specs for Your Appliance 

• 1 Processor – (2 Cores) 

• 4-8GB RAM 

• 80GB minimum Hard Drive space 

• Outlook 365 32Bit (Only)* 

• UAC (User Access Control) Must be disabled from the registry. (Reboot after disabling) 

In the unpacked folder for Add2Exchange is a folder called Setup. Open that folder and locate a file 

called “Disable_UAC” If you run this file (Right click, run with PowerShell) it will disable UAC for 

you.  

• All Microsoft Updates 

• PowerShell ver. 5.1 (You must update PowerShell on both your Exchange server and Appliance) 

Logging into your appliance for the first time 

*Ensure that your new sync service account is a Local Admin of your appliance before logging on. 
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PowerShell How to 
Before we continue, we have to make sure PowerShell is up to date on both your Exchange Server and your 

appliance. For users on Server 2016, Server 2019, or Windows 10, you will not have to perform the tasks 

below as PowerShell is up to date out of the box. 

On your appliance and/or your Exchange Server, open PowerShell as an Administrator: 

 

To figure out what version of PowerShell you are on: 

With the PowerShell window open type: Get-Host 

 

Hit Enter. 

You should see the Version number of PowerShell. In this case we already have version 5.1. 

 

If you do not have the latest version (5.1), please update via Microsoft Updates and reboot. 
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PowerShell Upgrade 

Note* For convenience, if you have already downloaded Add2Exchange and unpacked the self-extracting 

executable; you will find a folder called “Setup”. 

 

Open that folder and locate a PowerShell file called “Legacy_PowerShell”. 

 

Right click the file and Run with PowerShell: 

 

This will automatically take you through updating the PowerShell version on your appliance and Exchange 

Server.  

Note* Upgrading PowerShell will require a reboot. Please plan accordingly. 
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Setting up the Execution Policy 

We must now set the execution policy in PowerShell to remote signed on your appliance. 

Open PowerShell as an Administrator 

Type: Set-Executionpolicy -scope localmachine -executionpolicy remotesigned 

Press Enter 

 

Type “A” for Yes to All and click Enter 

PowerShell is now set with the proper execution policy and can exit the window. 
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Outlook Setup 
To begin with installation on your appliance we must first setup your Outlook profile: 

Note* Outlook must be the 32bit version of Outlook 365 

Go to your Control Panel and double click on the Mail Icon. 

 

Create a new Profile by clicking the Add button: 

 

Note* You can name the new profile anything here, but is recommended that you name the profile the email 

address of your new service account: 

 
 

Click OK when finished. 

 

 

 

 



 Add2Exchange Quick Start Guide 

© 2019 Advantage International Inc. / DidItBetter Software. All rights reserved 67 | P a g e  
 

On the next screen, click Next. 

Note* Ensure you are connecting to Office 365 

 

 

On the next screen you want to make sure that check the box “Change account settings” and click Next: 
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Make sure to uncheck “Use Cached Exchange Mode” on the next screen. When done, click Finish.  

Note* This new profile cannot be cached. 

 

Click OK to finish the profile setup: 

 

 

Open Outlook: 

 

Once Outlook opens click on File>Options. 
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Click on Add-ins and then the “Go…” button 

 

 

 



 Add2Exchange Quick Start Guide 

© 2019 Advantage International Inc. / DidItBetter Software. All rights reserved 70 | P a g e  
 

Note* In this next window it is extremely important to uncheck the Outlook Social Connector 

 

Click OK and go back into File>Options>Trust Center>Trust Center Settings 

 

In the next series of windows, we will check or uncheck certain features within Outlook. We will begin with 

Programmatic Access and work our way Up. Below are screen shots of how this should all look. 
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Once done, click OK and OK again.  
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Next, Click on Address Book 

 

When the Address Book opens, click on Tools>Options 

In this window, check custom and select Global Address List in the drop-down menu: 

 

When finished, click ok and exit out of Address Book. 

The last step to do is Define Send/Receive Groups: 
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Uncheck both “Include this group in Send/Receive” and check “Perform an automatic send/receive when 

exiting: 

 

When done, click close and File>Exit out of Outlook. 
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Installing Add2Exchange 
With the Add2Exchange download unpacked; locate the Add2Exchange.msi. Right click>Install 

 
 

Click Next 

Click “I Agree” and Next 
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Click Next on the next 2 screens: 

 

 

Choose the installation path and click Next.  

Note* We recommend defaults 
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Click Next when ready to continue: 

 

 

Enter your sync service account credentials when prompted and click OK: 
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On the next screen you will want to click on “Install Locally” This will install SQL express on your appliance 

for the Add2Exchange database. Click Yes to complete. 

 

On the next screen; click on “Create New A2ESQLServer” 

 

This next screen should automatically pick the Outlook Profile we created earlier. If no profile is visible, you 

can type it in manually below and click Accept: 
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Enter your sync service account credentials again and click OK: 

 

Once finished, click Close: 

 
 

On your desktop there will be a new icon called Add2Exchange Console. Double click it to open and start 

the silent SQL install. This process will take a few moments: 
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Once the install is finished you will be prompted stating that the database has been created successfully. Click 

OK, and the Add2Exchange console will now open.  
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Adding Permissions 
The last step is to add Permissions to the users we will be syncing with before you start to make relationships 

to them. Locate the directory were you downloaded and unpacked Add2Exchange. Open the Setup folder 

and locate the file called” PermissionsOnPremOrO365Combined” 

Right click the file and run with PowerShell: 

 

If you get an Execution Policy change prompt, select A for Yes to All and press Enter. 

  

In the next screen you will choose your environment. In this case we will type O for Office 365. Hit Enter to 

continue. 

 

If the MS Online module is not installed, this script will automatically update and install the modules 

necessary to continue. Yes, to all prompts when and if prompted. 

The next screen that pops up will be a login screen to Office 365. You need to login as your Tennant Admin 

to Office 365. 
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If login is successful, you will be prompted next to enter the Sync Service Account name (Display name) and 

hit Enter. 

Note* If logon was unsuccessful, simply close the PowerShell script and run it again. 

 

On the next screen you will have the option to give full access permissions to everyone, to a distribution list, 

or to just a single user. In this instance we will choose option 0 to add permissions to everyone. 

 

 

The last prompt will ask if you want to add permissions to public folders.  
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If you are trying to sync public folders, then type in Y and click Enter to continue. Follow the onscreen 

prompts until it prompts you for the Public Folder Name you want to use. At that point you can enter in the 

name of the public folders you need to give permissions to: 

 

Type in the name and click Enter. When finished, click N to not run this again. You are finished!!! You can 

now create relationships and start syncing with Add2Exchange. 
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Guided Installation Pre-Requisites 
 

Overview of your sync appliance 

We can install Add2Exchange on the current Operating Systems below: 

Windows Server Windows 

Server 2008 R2 x64 
Server 2012 x64 
Server 2012 R2 x64 
Server 2016 x64 
Server 2019 x64 
 

Windows 7 x64 
Windows 8.1 x64 
Windows 10 x64 

 

Recommended Min. Specs for your Appliance 

• 1 Processor – (2 Cores) 

• 4-8GB RAM 

• 80GB minimum Hard Drive space 

• Outlook 365 32Bit (Only)* 

• UAC (User Access Control) Must be disabled from the registry. (Reboot after disabling) 

In the unpacked folder for Add2Exchange is a folder called Setup. Open that folder and locate a file 

called “Disable_UAC” If you run this file (Right click, run with PowerShell) it will disable UAC for 

you.  

• All Microsoft Updates 

• PowerShell ver. 5.1 (You must update PowerShell on both your Exchange server and Appliance) 

Logging into your appliance for the first time 

*Ensure that your new sync service account is a Local Admin of your appliance before logging on. 

In this guide we will show how the guided install of Add2Exchange works, and how to get started.  

The first step will be to download Add2Exchange Here 

 

 

 

 

 

 

 

 

 

 

 

http://support.diditbetter.com/Secure/Login.aspx?returnurl=/downloads.aspx
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Setting up the Execution Policy 

We must now set the execution policy in PowerShell to remote signed on your appliance. 

Open PowerShell as an Administrator 

Type: Set-Executionpolicy -scope localmachine -executionpolicy remotesigned 

Press Enter 

 

Type “A” for Yes to All and click Enter 

PowerShell is now set with the proper execution policy and can exit the window. 

Once Add2Exchange is downloaded on the box we will install on, double click the file to automatically 

unpack its contents. 

Within the unpacked contents you will see in the root folder 2 specific files. One called 

“RUN_ME_FIRST.ps1” and “1ClickSetup” 

 

The first file we will run is the “RUN_ME_FIRST.ps1” 

Right click>Run with PowerShell 

Note* This PowerShell script will run you through the following: 

• Account Creation (Create the new account that we will install under) 

• Upgrade .Net and PowerShell if needed (If PowerShell or .Net are not up to date, this script will 

automatically do it for you) 

• Create zLibrary folder (Creates a folder called zLibrary in the root of C) 

• Create Shortcuts (Creates desktop informational shortcuts) 

• Install Outlook and Setup Profile (If Outlook is already installed, then it will skip this) 

• Mailbox Creation (Will prompt for mailbox creation) 

• Create a Mail Profile (Creating the Outlook profile on the replication appliance) 

• Disable UAC (Will disable UAC in the registry. You must reboot afterwards) 
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When finished, click OK and reboot. 

Note* If PowerShell or .Net was updated via the PowerShell script, reboot when finished and run the script 

again. 
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Once the box has been rebooted, we can now move to the next step of our installation.  

Note* Before continuing, ensure the following is complete: 

1. Sync service account has been created 

2. The service account is a local admin of the appliance we will install on 

3. You are logged in as that service account 

4. The outlook profile has been setup WITHOUT Cache mode 

 

The Second file we will run is the “1ClickSetup.ps1” 

Right click>Run with PowerShell 

Note* This PowerShell script will run you through the following: 

• Add Permissions (Guided permissions to users we will sync too) 

• Add Public Folder Permissions (If syncing with public folders) 

• Enable Auto Logon (Enables the box to be auto logged on if rebooted) 

• Install Add2Exchange 

• Add Registry Favorites (Adds Registry favorites in Regedit) 

If you get an Execution Policy change prompt, select A for Yes to All and press Enter. 

  

In the next screen you will choose your environment. In this case we will type E for Exchange 2013-2016. Hit 

Enter to continue 

 

The next question will ask you if you are on the Exchange server. In this case, we are running this directly on 

the sync appliance. Type N and hit Enter. 
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A pop up will come up if you type in N. This explains how to turn on PS Remoting. Click OK to continue. 

 

 

The next prompt will ask you for your Exchange server name. If running in a clustered or CAS environment, 

just type in the name of a single mailbox server and click Enter. This will pull in and load exchange PS 

Remoting locally to this box. 

 

Login as an Administrator to your Exchange server. If login is successful, you will be prompted next to enter 

the Sync Service Account name (Display name) and hit Enter. 

 

On the next screen you will have the option to give full access permissions to everyone, to a distribution list, 

or to just a single user. In this instance we will choose option 0 to add permissions to everyone. 

Note* This will also automatically add the Add2Exchange throttling policy for the sync service account. 

 



 Add2Exchange Quick Start Guide 

© 2019 Advantage International Inc. / DidItBetter Software. All rights reserved 88 | P a g e  
 

 

The last prompt will ask if you want to add permissions to public folders.  

 

If you are trying to sync public folders, then type in Y and click Enter to continue. Follow the onscreen 

prompts until it prompts you for the Public Folder Name you want to use. At that point you can enter in the 

name of the public folders you need to give permissions to: 
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Click Next 

Click “I Agree” and Next 
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Click Next on the next 2 screens: 

 

 

Choose the installation path and click Next.  

Note* We recommend defaults 

 
 



 Add2Exchange Quick Start Guide 

© 2019 Advantage International Inc. / DidItBetter Software. All rights reserved 91 | P a g e  
 

Click Next when ready to continue: 

 

 

Enter your sync service account credentials when prompted and click OK: 
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On the next screen you will want to click on “Install Locally”. This will install SQL express on your appliance 

for the Add2Exchange database. Click Yes to complete. 

 

On the next screen; click on “Create New A2ESQLServer” 

 

This next screen should automatically pick the Outlook Profile we created earlier. If no profile is visible, you 

can type it in manually below and click Accept: 
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Enter your sync service account credentials again and click OK: 

 

Once finished, click Close: 

 
 

On your desktop there will be a new icon called Add2Exchange Console. Double click it to open and start 

the silent SQL install. This process will take a few moments: 
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Once the install is finished you will be prompted stating that the database has been created successfully. Click 

OK, and the Add2Exchange console will now open.  
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Once finished, we have one bit of House cleaning to take care of before we start using Add2Exchange. 

Continue below to Outlook Setup. 
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Outlook Setup Guided 
Open Outlook: 

 

Once Outlook opens click on File>Options 

 

Click on Add-ins and then the “Go…” button. 
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Note* In this next window it is extremely important to uncheck the Outlook Social Connector. 

 

Click OK and go back into File>Options>Trust Center>Trust Center Settings. 

 

In the next series of windows, we will check or uncheck certain features within Outlook. We will begin with 

Programmatic Access and work our way up. Below are screen shots of how this should all look. 
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Once done, click OK and OK again.  
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Next, click on Address Book. 

 

When the Address Book opens, click on Tools>Options. 

In this window, check custom and select Global Address List in the drop-down menu: 

 

When finished, click ok and exit out of Address Book. 

The last step to do is Define Send/Receive Groups: 
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Uncheck both “Include this group in Send/Receive” and check “Perform an automatic send/receive when 

exiting: 

 

When done, click close and File>Exit out of Outlook. 

You are finished!!! You can now open the Add2Exchange console, create relationships and start syncing. 
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Wrap-Up Notes Post Installation 

 
❖ It is recommended to enable Auto Login on the replication appliance to ensure the box automatically 

logs back on and start syncing. If the appliance is logged off, replication will not take place. The 

appliance needs to be logged in at all times. Note* You can lock the box, but do not log off. 

The auto logon application can be found in the unpacked Add2Exchange download under setup. 

 
Run the utility and fill in the credentials for the sync service account. When finished, click Enable. 

 
 

❖ If using Contacts sync or GAL Sync, make a group policy to turn off Outlook Social Connector for 

each version of Outlook supported.   

If users have personal Outlook on a machine which is off the domain, and not a part of Group 

Policy, it is best practices to disable the Outlook Social Connector in Add-ins of Outlook.  See here:  

Contacts: 

How to disable Outlook Social Connector by Group Policy or GP Edit 

From Microsoft: Manage the Outlook Social Connector with Group Policy 

❖ Ensure to add Antivirus exclusions for our directories (C:\Program Files (x86)\OpenDoor 

Software®) 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://support.diditbetter.com/best-practices-on-syncing-calendar-appointments-and-contacts.aspx
http://support.diditbetter.com/disable-group-policy.aspx
https://support.microsoft.com/kb/2020103
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Add2Exchange Console Overview 
 

Now that Add2Exchange is installed we can look at some of the features and options in the Add2Exchanne 

Console. To start off with, make sure you are always logged in as the Sync Service account before opening the 

console. Not doing so will create extra profiles in the registry and the console will fail to load. 

Start off by logging on to the Sync appliance using the Sync service account> 

On the desktop will be a shortcut named Add2Exchange Console. Double click to open. 

 

Once open, you will see the console below: 

 

Note* All modules (Calendars, Contacts, Tasks, etc. will be in trial mode for 21 days as soon as you make 

your first relationship.) 
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Help 
With the console open, let’s click on Help. 

 

Here we see where you can check: 

• Release Notes 

• EULA updated license agreement 

• About the software and current version 

• Export Setup to export the current setup in .txt form 

• View the Manual 

• Shop Online 

• Open a Ticket HERE 

• Visit www.DidItBetter.com 

License 
Moving on to the left we have the License tab 

 

This is where we can input individual license keys for the different modules as well as request license keys for 

newly purchased modules. 

 

 

 

 

http://support.diditbetter.com/support-request.aspx
http://www.diditbetter.com/
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Service and Utility 
Next is the Service and Utility tab. 

 

 

Process Interval 

In this first tab you will see all of the services that run when executing the Add2Exchange service.  

• Global Address List Sync Manager: (GAL.Mgr.) Controls the time between syncs that the GAL is 

synced. This can be changed at any time from minutes, hours, or days. 

• Relationship Group Manager: (Rel.Mgr.) Controls the time between syncs that Rel Manager is 

synced. This can be changed at any time from minutes, hours, or days. 

• Notes: Controls the time between syncs that Notes are synced. This can be changed at any time from 

minutes, hours, or days. 

• Calendar: Controls the time between syncs that Calendars are synced. This can be changed at any 

time from minutes, hours, or days. 

• Contacts: Controls the time between syncs that Contacts are synced. This can be changed at any time 

from minutes, hours, or days. 

• Tasks: Controls the time between syncs that Tasks are synced. This can be changed at any time from 

minutes, hours, or days. 

• Post Notifier: Controls the time between syncs that Post Notifier is synced. This can be changed at 

any time from minutes, hours, or days. 

• Posts: Controls the time between syncs that Posts are synced. This can be changed at any time from 

minutes, hours, or days. 
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Note* If the time is set to 0, then the service will not run for that particular module. It is recommended 

you turn off anything not needed to save time on sync cycles.  

 

Application Logging 

The next tab shows how the application will log events while running the synchronization. It is recommended 

that Start and Stop Event Logging Only is selected here, unless trying to diagnose an issue in which Full 

Event logging would be needed.  

 

Application Performance 
Application performance should almost always be set to max. (All the way to the left for both sliders).  
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Status of Required Services 
This tab just illustrates if a service is Up (True) or Down (False). Mainly used for legacy products. 

 

Load Users 

In this tab we see three different options in the case if we have to manually add mailboxes to the Outlook 

profile. This would only be used in specific cases were Exchange or Office 365 might not be able to load the 

user mailboxes fast enough. With the mailbox already loaded in Outlook, Add2Exchange can quickly grab the 

information it needs to sync and then remove that mailbox from the Outlook profile.  
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Tools 
In the next tab in the Add2Exchange console we have three options.  

• Global Options 

• Empty Trash 

• GAL Sync Options 

 

 

Global Options 
The first tab you will see under Global Option is Recurring Appointments. 

 

This is showing the amount of days to go back and catch the first instance of re occurring appointments. Re 

occurring appointments work a bit differently than regular appointments as you must go back far enough to 

catch the first instance when it was created. Note* It is recommended to leave this as default. If you have re 

occurring appointments that date back a few years, now is the time to clean those items up and edit them to 

start from today’s date on if you are syncing calendars.  

Support Tip* Why do you want to do this? A single calendar item may only be a few KB or a few hundred 

KB. Now times that by how many re occurrences of that item over how many years and you have 

transformed a few KB into a tremendous amount of data that is being pushed around and taking up 

unnecessary network traffic. 
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Backups 
Here we can choose how often Add2Exchange takes backups of your current configuration. 

 

Look and Feel 

On the next tab we have 2 options of how we may view the Add2Exchange console.  
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Empty Trash 
When Empty Trash is selected, Add2Exchange will force delete any relationships in the trash that were not 

removed prior. Note* You must run a full sync after clicking the Empty Trash Button in order for 

Add2Exchange to clear the trash. 

 

 

GAL Sync Options 

This window allows you to turn on the GAL synchronization module. You must pick a folder were the GAL 

will be cached from Active Directory in order to sync to any/all of your users. This folder can be within a 

mailbox or Public folder.  
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GAL Exclusions 
The GAL Exclusions tab is where you can exclude or include individual members from the GAL Sync. Once 

done, make sure to click Apply first and then OK. 

 

Note* You will want to exclude any distribution groups, or any users that are hidden or do not have a 

mailbox. 

You can always come back to this page and make adjustments as needed even after a sync has taken place.  

 

 

Relationship 
On the next tab we have Relationship that allows the ability to start creating relationships. If you are making 

relationships individually then this is the route you would want to take.  

Note* For all modules (Calendars, Contacts, Tasks etc. You will want to use the (Single 1 to 1) setting.  
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Relationship Group Manager 
In order to make templates for syncing to a distribution list, you will want to first start off here in 

Relationship Group Manager. Found under Relationship>Relationship Group Manager. 

 

Here we can see where you can make new templates on the left-hand side, and add them to distribution 

groups on the right-hand side. More on this when we get into making template relationships.  
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Creating Single (1 to 1) Relationships 

Source to Destination 
 

One-Way & Two-Way Relationship Creation 
To begin with, log into the Add2Exchange appliance as the Sync service account. From there, open the 

Add2Exchange Console.  

 

Once open, you will see the console below: 

 

On the tab pane, click Relationship>Add> (Calendars, Contacts, Tasks etc.) >Single (1 to 1) 
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On the next window you will want to choose which direction you want to sync. Your choices are as follows: 

• Private to Public 

• Private to Private 

• Public to Public 

• Public to Private 

In this instance, we will be creating a Public to Private Calendar relationship. (1 Source to 1 Destination) 

Once you have chosen the direction click Select. 

 

On the next screen you will be prompted to choose the Public Folder (Source Folder) to Sync from. Ensure 

that the Sync Service account has the proper permissions to access the public folder. Note* Typically we 

have the Sync Service account as an Owner of the public folder we are syncing to or from. Once you have 

highlighted your selection, click Select One. 

 

Now it’s time to pick your Destination mailbox. Click Select Mailbox under Destination 
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Pick a single user from the GAL (Global Address List). 

Note* The Sync Service account must have the proper permissions to any user you choose here. If you have 

not run permissions yet, please read HERE. 

 

Once you have made you selection click OK. The next window that comes up will enumerate the user’s 

mailbox. From here, you will pick the folder within that mailbox to sync to (Destination). 

 

Note* If the folder picker window shows blank, then we do not have the proper permissions to that user. 
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At this time, you may also create a New Folder if you do not wish to sync into the default calendar. Simply 

click New Folder while Calendar is highlighted, and type in the name of the new folder you wish to sync into.  

Once your selection is finished, click Select One. 

 

Now we are at the main window where we have a few different options of how we want to sync this single 

relationship. The first field under Parameters allows us to Place Text Before or After the subject line of the 

items that are being synced to the destination. 

For Example: We can click Before / and then type in Firm Calendar 

 

This will put the words Firm Calendar before the subject line on every item synced to this user from the 

source Public Folder. The calendar item would then look like this:  

Firm Calendar: Conference Room Appointment 

The information to decide to populate should be decided before you start to sync any items to ensure that 

everyone wants to have this kind of functionality. If you do not want to populate the fields before or after the 

subject line, then just leave the Parameters portion blank. 

 

Moving on below we have Synchronization range days. 
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The range should be however many days forward (Future) and back (Past) you want to sync. In the picture 

above, we have 90 days in the future and 0 days in the past. You can change this number at any point in time. 

Note* If you have a lot of reoccurring appointments that were created years ago, it would be wise to edit 

those items to have a starting point from today on. If not, you must put the prior days back far enough to 

capture the first instance of the re occurrence in order for the item to sync properly. It is not recommended 

to sync multiple years in the past just to capture a re-occurrence just for the shear amount of unnecessary data 

you would be pushing across the network.  

You also have the option to “Skip Private Items” if the source items you are attempting to sync are marked as 

private in Outlook.  

Lastly, you have the option to “Match Reminder to Source” 

 

Moving further down we have rules per relationship. These rules are as follows 

• Conflict Resolution 

• Copied Resolution 

• Source Item Deleted Resolution 

• Destination Item Deleted Resolution 

• For Existing Items in the Source 

• For Existing Items in the Destination 

By default, Add2Exchange uses One-Way Synchronization setup as shown below: 
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One-Way Synchronization allows for the source folder to “Always Win”. If a destination item is deleted, then 

the Source item will be recopied to the destination. You may also click on any of the question marks on the 

right-hand side for more information when choosing rules.  

When finished with your selection, click OK. 

The next screen will ask if the relationship name on top is acceptable. Now is the time to change the name if 

you choose. Click “Yes” when finished. 

 

The next screen will ask if you want to create a 2-way relationship, meaning it will automatically make the 

reverse relationship from what we had just created. In this instance we will say “Yes” 

 

 

 

 



 Add2Exchange Quick Start Guide 

© 2019 Advantage International Inc. / DidItBetter Software. All rights reserved 118 | P a g e  
 

With the new relationship created for us, we will click OK on the bottom right hand side to complete this 

relationship.  

 

As you can see above, we started off with choosing a Public to Private Sync. After choosing a 2-way 

relationship, Add2Exchange reverses the relationship for us, so that items in the Private will now sync back 

down to the Public Folder.  

On the next screen, Add2Exchange will ask if you want to create another relationship. Click No, to return 

back to the console.  

 

Back into the console we can now see the relationships we created for this user highlighted in Blue. 

 

Note* Relationships highlighted in blue indicate that the relationships have never synced yet. They are still 

brand new. Once the relationships have successfully synced, then they will change color back to black along 

with information showing when they were synced last and how much time it took to sync.  

You can now create One-Way and Two-Way relationships using the above method in the same way for 

Calendars, Contacts, Tasks, Posts, and Notes. 
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Creating a Full-Mesh 
A Full-Mesh synchronization is used to “Complete the cycle” in an environment where you have Public to 

Private sync and Private back to the Public two-way sync. In this Instance we have: 

Public to Private Sync (Source to Destination) 

Private to Public Sync (Destination back to original Source) 

But what is missing here is the Private to Private sync (Full-Mesh).  

 

When an item gets copied from the Source folder to its Destination, that item is now an Add2Exchange copy. 

Add2Exchange does not copy a copy and therefore will not synchronize that copy that is now in the 

destination to another folder. Using the example above we have User C and D syncing down to the Public 

Folder as well as the Public Folder Syncing back up to User C and D. But if you need User C’s Items to sync 

to Users D’s Items, then we must create Private to Private Relationships to complete the cycle. This is what is 

called a Full-Mesh.   

In order to complete the sync, let’s create a Private to Private Relationship and Pick User C as the source and 

User D as the Destination.  

 

Once finished, click OK and make sure to click Yes when asked if you want to create a 2-way relationship for 

Users C and D. 
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When finished, you should have the equivalent to the below example: 

 

The example above shows a Full-Mesh relationship for 2 users including the Public Folder. If adding more 

users (Users A and B), then you need to create more relationships as follows: 

• User A to User B 

• User A to User C 

• User A to User D 

• User B to User A 

• User B to User C 

• User B to User D 

• Etc. 

It is important to note that this can grow exponentially when attempting to add 20+ users to a full mesh; 

thus, planning is important prior to setting up your relationships. 

Note* This covers making relationships manually one by one which in certain circumstances (only 2 users) 

would be warranted. A much easier and automatic way to achieve this is to use Relationship Group Manager.  

With your new relationships made, it’s time to run a full sync cycle. Continue to Syncing Add2Exchange to 

see how. 
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Deleting Relationships 
From time to time you may need to delete relationships and remove destination copies for either someone 

not wanting a certain sync, or for someone no longer with your organization. This is pretty easy. 

To begin with, log into the Add2Exchange appliance as the Sync service account. From there, open the 

Add2Exchange Console.  

 

Once open, expand the module in which you intend to delete relationships from: 

 

Simply right click the relationship you want to delete, and click Delete.  

 

Click OK on the next window 
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Yes, to confirm deletion 

Then enter the reason for Deletion 

 

On the next screen you almost always 99% of the time want to choose “Remove Destination Copies”. This 

will cleanup (Remove) all items synced to this user.  

Note* If the mailbox or user has already been disabled then Add2Exchange will not be able to cleanup. 
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The relationship is now marked as deleted, and will cleanup on the next sync cycle.  
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Relationship Template Creation 

with Relationship Group Manager 
The easiest method for any type of synchronization and management is using Relationship Group Manager to 

create templates of what you want to sync and then attach those templates to Distribution Lists with the users 

you intend to sync with. The goal with Relationship Group Manager is to give the user the ability to: 

• Create a template (Source to Destination) for Calendars, Contacts, or Tasks. 

• Attach that template to a Distribution list that will contain all users you want to sync with 

• Manage Add2Exchange solely from the Distribution Group 

• Automatic Creation of Relationships 

Once a template is created and attached to a distribution list, you can essentially manage the sync directly 

from the Distribution List itself, without ever having to go into the Add2Exchange Console again. 

In this example, we will create a Template for Public Folder Contacts to sync to Multiple Users located in a 

Distribution list. It is important to note that you may use this to create One-Way, Two-Way or Full Mesh 

Templates using the same methods below. Let’s begin. 

The first step is to create a Distribution List within your Exchange environment or Office 365. For this 

example, we will be using Exchange 2016.  

Log into Exchange Admin Center as an Administrator. 

 

Locate “groups” and Add a new Distribution Group. 
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Create the new Distribution List using a name that is easily recognizable in the Global Address List. We 

usually put a Z in front of the display name to drop it to the bottom of the GAL since this group cannot be 

hidden. 

Note* It is not recommended to use pre-existing groups here. Create a new group just for Add2Exchange. It 

is also recommended that the Display Name and Alias Name be exactly the same.  

 

Add all members to the group that you want to sync with. When finished, click Save. 
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With our new group created, we can return to the Add2Exchange Console.  

Note* If you have not yet added Add2Exchange permissions to your users, see HERE before continuing.  

Log into the Add2Exchange appliance as the sync service account, and open the Add2Exchange Console. 

From here, navigate to Relationship>Relationship Group Manager. 

 

 

 

Click “New” 
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Notice we click on “Contact” for Folder Type. Then click Select, and then Next. 

On the Next screen, we will choose “Public to Private”. Then click Select and Next. 

 

Note* Ensure that the sync service account has proper permissions to the public folder before clicking Next. 

If you are unsure, open the permissions tab on the public folder you are trying to sync with in Outlook. 

Check to see if the sync service account is an owner of that public folder.  
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On the next screen, pick the public folder you want as your “Source” folder. 

 

Once selected, click on Select One and then hit Next. 
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On the next screen, we will choose the Destination folder.  

Note* Notice that the “Template Side” is checked, and once you click select mailbox, it should automatically 

pick the sync service account mailbox. This is because we use the service account mailbox as the template. 

Whatever you do here will automatically populate for everyone else.  

 

As an example, we will hit “Select Mailbox”. 

This will automatically enumerate the sync service account mailbox. If you do not want to sync into the 

default contacts folder and instead want to sync in a separate or subfolder contacts, then simply hit New 

Folder. Type in the name of this folder, highlight it, and hit Select One.  

 

Now we have created a new folder in the template for the Destination side. This new folder will now be 

created for everyone in the Distribution group we created once we attach this template. When finished hit 

Next. 
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The first field under Sync Parameters allows us to Place text before or After the subject line of the items that 

are being synced to the destination. 

For Example: We can click Before / and then type in Firm Contacts. 

 

This will put the words Firm Contacts before the subject line on every item synced to this user from the 

source Public Folder. The contact item would then look like this:  

Firm Contacts: Anthony Griffin 

The information to decide to populate should be decided before you start to sync any items to ensure that 

everyone wants to have this kind of functionality.  You may also use the Automatic Pop Option drop down 

to auto fill the text with pre-designated options. If you do not want to populate the fields before or after the 

subject line, then just leave the Parameters portion blank. 

You also have the option to “Skip Private Items” if the source items you are attempting to sync are marked as 

private in Outlook.  

Lastly, you have the option to “Match Reminder to Source” 

 

When finished, click Next. 
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In the next screen we have the rules to determine how changes and deletions are handled. By default, 

Add2Exchange is setup to be a one-way Sync.  

 

If at any time you want to change these rules, simply hit the Lock icon on the top left side of the screen. This 

enables you to choose the top 4 fields.  

 

When finished, hit the Lock icon again to lock in your changes and hit Next. 

Note* you can come back and change these rules at any time if need be. 
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On the next screen we have the Deletion Options. By default, “Remove Destination Copies” is selected and 

is the only option for template creation. When a user is removed from the distribution list, Add2Exchange 

will automatically remove the relationship and clean up (Remove) any items synced to that user on the next 

replication cycle.  

 

Click Select, and then Next.  

Onto the next screen, we have synchronization fields. We can choose what fields you want to sync to your 

users. For all fields, leave as default and click Next. For majority of users, we “Select Fast” since all the fields 

in Fast mode are seen and used by Outlook. There are a lot of fields that Outlook does not use, or maybe you 

might not use if all fields are selected. When finished, click Next. 
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On the last screen, you have the option to change the relationship name as well as “Automatically make the 

reverse of this Relationship”. If you check the box below, it will automatically choose the appropriate source 

and destination folders for a 2-way-sync. If a 2-Way sync is not needed, simply select Finish.  

 

2-Way Sync (Bi-Directional Template) 
If you do want a 2-Way sync and eventually a Full-Mesh then check the box for “Automatically make the 

reverse of this Relationship” and click Finish.  
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This will now take you back to Step 1 for a 2-Way Sync. Click Next all the way through making sure you 

change anything you want to customize since this is now the reverse sync. 

 

 

Click Finish when done.  

 

 

 

 

 



 Add2Exchange Quick Start Guide 

© 2019 Advantage International Inc. / DidItBetter Software. All rights reserved 135 | P a g e  
 

Full-Mesh Sync with Relationship Group Manager 
Now that we have our 2-Way (Bi-Directional) sync with our templates, we will need a Full-Mesh Template if 

you intend for items to sync between individual users using the same Distribution List. 

A Full-Mesh synchronization is used to “Complete the cycle” in an environment where you have Public to 

Private sync and Private back to the Public two-way sync. In this Instance we have: 

Public to Private Sync (Source to Destination) 

Private to Public Sync (Destination back to original Source) 

But what is missing here is the Private to Private sync (Full-Mesh).  

 

When an item gets copied from the source folder to its destination, that item is now an Add2Exchange copy. 

Add2Exchange does not copy a copy and therefore will not synchronize the copied item in that destination 

folder to another folder. Using the example above we have the Public Source folder “Firm Contacts” syncing 

to the template mailbox folder “Firm Contacts” We also have the reverse of this selection. But if you need 

the users to sync amongst each other as well then we will need to create another template syncing the 

templates folder “Firm Contacts” to “Firm Contacts”. This is what is called a Full-Mesh. 

Click on New 

 

This is a Contact Folder Type. Hit Select and Next.  
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This will be our Full-Mesh setup so click “Private to Private”, then Select and Next. 

 

On Step 3, we are leaving the “Template Side” checked and select the Firm Contacts folder from the service 

accounts mailbox.  Click Next when finished.  
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The next screen will automatically choose the service accounts folder Firm Contacts. Click Next. 

 

On the next few screens, choose the appropriate behavior. In this instance we will leave everything as default.  
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On Step 9, we will match what we have chosen for the other two templates created prior. In this instance we 

will choose “Select Fast” Click Next 
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Once finished, you should have 3 templates setup for a Full-Mesh. 

 

Now it’s time to Attach the Distribution List to all of your templates. 

Attaching a Distribution List to Templates 
On the right-hand side on the Relationship Group Manager main window you will see a drop down for 

Distribution Group as well as a button that says “Get Group” 

 

Since we do not have any Distribution Lists in the drop down yet, we must pick it from the Global Address 

List. Click “Get Group” and select the Distribution List you created for this sync. 
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Once the group is selected click OK. 

 

You will now see all the members of that group populate in the console.  

 

 

To attach the Distribution List to the template simply highlight the template you want to attach first, and then 

click “Attach Template”. 
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If you have more templates to attach to the same Distribution List, then repeat this step until all templates are 

attached.  

Note* It is recommended if you are creating templates for Calendars, and Contacts, or Tasks, that you use 

individual Distribution Lists for each module. For example: 

• zFirmCalendars (Contains all members for Calendar Sync Only) 

• zFirmContacts (Contains all members for Contact Sync Only) 

When finished, you can close out the Relationship Group Manager window.  

 

 On the main Add2Exchange Console, you should now see all of your templates under Contacts. 

 

Note* Templates highlighted in blue indicate that the templates have never synced yet. They are still brand 

new. Once the templates have successfully synced, then they will change color back to black along with 

information showing when they were synced last and how much time it took to sync. 

With your templates made, it’s time to run a full sync cycle so Add2Exchange can automatically make all of 

your relationships. Continue to Syncing Add2Exchange to see how. 

Note* From this point on, if you ever need to add users to the sync or remove users, all you have to do is 

add or remove them from the appropriate distribution list. Add2Exchange will take care of the rest. 
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Global Address List Syncing 
In order to Start syncing your Global Address List to your users, the first step is to create a Distribution List 

within your Exchange environment or Office 365. For this example, we will be using Exchange 2016.  

Log into Exchange Admin Center as an Administrator. 

 

Locate “groups” and Add a new Distribution Group. 

 

 

Create the new Distribution List using a name that is easily recognizable in the Global Address List. We 

usually put a Z in front of the display name to drop it to the bottom of the GAL since this group cannot be 

hidden. 
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Note* It is not recommended to use pre-existing groups here. Create a new group just for Add2Exchange. It 

is also recommended that the Display Name and Alias Name be exactly the same.  

 

Add all members to the group that you want to sync with. When finished, click Save. 

 

With our new group created, we can return to the Add2Exchange Console.  

Note* If you have not yet added Add2Exchange permissions to your users, see HERE before continuing.  

Log into the Add2Exchange appliance as the sync service account, and open the Add2Exchange Console. 

From here, navigate to Relationship>Relationship Group Manager. 

 



 Add2Exchange Quick Start Guide 

© 2019 Advantage International Inc. / DidItBetter Software. All rights reserved 144 | P a g e  
 

 
Click “New” 

 

Click on “Contact” for folder type and then check “GAL Relationship” and hit Select. 

A new window will open prompting you to choose the landing folder for your cached GAL. Pick the Folder 

you choose to use whether it be in a private mailbox or a public folder. Regardless of choice, ensure that the 

sync service account has the proper permissions to that folder. Click Select One. 

 

Note* Add2Exchange will grab the Global Address List and drop it into this landing folder. From there, it 

will sync out to all users defined in the distribution list. 
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Now that we have the landing “GAL Cache” folder picked, let’s move onto exclusions. Click the GAL 

Exclusions tab on top. 

 

The GAL Exclusions tab is where you can exclude or include individual members from the GAL Sync. Once 

done, make sure to click Apply first and then OK. 

 

Note* You will want to exclude any distribution groups, or any users that are hidden or do not have a 

mailbox. 

You can always come back to this page and make adjustments as needed even after a sync has taken place. 
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After completing GAL Exclusions, you are brought back to Step 1. Click on “Select” and then Next. 

 

On the next step, the proper message type is automatically selected for you. Hit “Select” and Next. 

 

On the next screen, we will choose the Destination folder.  

Note* Notice that the “Template Side” is checked, and once you click select mailbox, it should automatically 

pick the sync service account mailbox. This is because we use the service account mailbox as the template. 

Whatever you do here will automatically populate for everyone else.  
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As an example, we will hit “Select Mailbox” 

This will automatically enumerate the sync service account mailbox. If I do not want to sync into the default 

contacts folder and instead want to sync in a separate or subfolder contacts, then simply hit New Folder. 

Type in the name of this folder, highlight it, and hit Select One.  

 

Now we have created a new folder in the template for the Destination side. This new folder will now be 

created for everyone in the Distribution group we created once we attach this template. When finished hit 

Next. 

The first field under Sync Parameters allows us to place text Before or After the Subject line of the items that 

are being synced to the destination. 

For Example: We can click Before / and then type in Firm Contacts. 
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This will put the words Firm Contacts before the subject line on every item synced to this user from the 

source Public Folder. The contact item would then look like this:  

Firm Contacts: Anthony Griffin 

The information to decide to populate should be decided before you start to sync any items to ensure that 

everyone wants to have this kind of functionality.  You may also use the Automatic Pop Option drop down 

to auto fill the text with pre-designated options. If you do not want to populate the fields before or after the 

subject line, then just leave the Parameters portion blank. 

When finished, click Next. 

In the next screen we have the rules to determine how changes and deletions are handled. By default, 

Add2Exchange is setup to be a one-way sync.  

Note* For GAL Sync, leave these fields as default. 
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On the next screen we have the Deletion Options. By default, “Remove Destination Copies” is selected, and 

is the only option for template creation. When a user is removed from the distribution list, Add2Exchange 

will automatically remove the relationship and clean up (remove) any items synced to that user on the next 

replication cycle.  

 

Click Select, and then Next.  

Onto the next screen, we have synchronization fields. We can choose what fields you want to sync to your 

users. For all fields, leave as default and click Next. For majority of users, we “Select Fast” since all the fields 

in Fast mode are seen and used by Outlook. There are a lot of fields that Outlook does not use, or maybe you 

might not use if all fields are selected. When finished, click Next. 
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On the last screen, you have the option to change the relationship name. When done, simply select Finish.  

 

Attaching the GAL Template to a Distribution List 
On the right-hand side on the Relationship Group Manager main window you will see a drop down for 

Distribution Group as well as a button that says “Get Group”. 

 

Since we do not have any Distribution Lists in the drop down yet, we must pick it from the Global Address 

List. Click “Get Group” and select the Distribution List you created for this sync. 
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Once the group is selected click OK. 

 

You will now see all the members of that group populate in the console.  

 

To attach the Distribution List to the template simply highlight the Template you want to attach first, and 

then click “Attach Template”. 
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Note* It is recommended if you are creating templates for Calendars, and Contacts, or Tasks, that you use 

individual Distribution Lists for each module. For example: 

• zFirmCalendars (Contains all members for Calendar Sync Only) 

• zFirmContacts (Contains all members for Contact Sync Only) 

• zGALSync (Contains all members for GAL Sync Only) 

When finished, you can close out the Relationship Group Manager window.  

 

 On the main Add2Exchange Console, you should now see all of your templates under Contacts. 
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Note* Templates highlighted in blue indicate that the templates have never synced yet. They are still brand 

new. Once the templates have successfully synced, then they will change color back to black along with 

information showing when they were synced last and how much time it took to sync. 

With your templates made, it’s time to run a full sync cycle so that Add2Exchange can automatically make all 

of your relationships. Continue to Syncing Add2Exchange to see how. 

Note* From this point on, if you ever need to add users to the sync or remove users, all you have to do is 

add or remove them from the appropriate distribution list. Add2Exchange will take care of the rest. 
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Deleting Add2Exchange Templates 
From time to time you may need to delete templates and remove destination copies. This is pretty easy. 

Note* When deleting templates; take note that once a template is deleted, it will also delete all relationships 

associated within that template.  

To begin with, log into the Add2Exchange appliance as the Sync service account. From there, open the 

Add2Exchange Console.  

 

Open the Add2Exchange Console. From here, navigate to Relationship>Relationship Group Manager 

 

Select the Template you want to delete and click on Delete. 
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Click Yes 

Hit Next through all the steps in the next few windows. 

 

When done, click Finish. 

 

Click Yes. 
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Hit Ok. 

The template is now deleted, and will show all of the deleted relationships in the trash.  

 

In order for the deleted relationships to cleanup and all destination items removed, you must run a full sync 

cycle until completion. Show Me How 
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Syncing Add2Exchange 
Now that all of your relationships are setup, it’s time to start your first sync. 

 

Before we start, let’s make sure we have the proper services turned on. 

In the console click Service>Utility 

 

In this first tab you will see all of the services that run when executing the Add2Exchange service.  

• Global Address List Sync Manager: (GAL.Mgr) Controls the time between syncs that the GAL is 

synced. This can be changed at any time from minutes, hours, or days. 
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• Relationship Group Manager: (Rel.Mgr) Controls the time between syncs that Rel Manager is synced. 

This can be changed at any time from minutes, hours, or days. 

• Notes: Controls the time between syncs that Notes are synced. This can be changed at any time from 

minutes, hours, or days. 

• Calendar: Controls the time between syncs that Calendars are synced. This can be changed at any 

time from minutes, hours, or days. 

• Contacts: Controls the time between syncs that Contacts are synced. This can be changed at any time 

from minutes, hours, or days. 

• Tasks: Controls the time between syncs that Tasks are synced. This can be changed at any time from 

minutes, hours, or days. 

• Post Notifier: Controls the time between syncs that Post Notifier is synced. This can be changed at 

any time from minutes, hours, or days. 

• Posts: Controls the time between syncs that Posts are synced. This can be changed at any time from 

minutes, hours, or days. 

Note* If the time is set to 0, then the service will not run for that particular module. It is recommended you 

turn off anything not needed to save time on sync cycles. 

In this instance we are syncing the GAL (Global Address List), Rel Mgr. (Relationship Group Manager), 

Calendars, and Contacts. Make sure to set the appropriate times you want Add2Exchange to sync.  

Note* The time you set for Rel. Mgr. will be the control for checking changes within the Distribution list. If 

the time you set here is 12 Hrs. then the service will run every 12 hrs. to check if you had made any changes 

within the Distribution List.  

With everything set in place, we can now start the sync. Click OK on the Services windows, then click File 

and the Exit on the Add2Exchange Console.  

When exiting the Console, you are prompted to start the Add2Exchange Service. Clicking No will prevent 

the Service from running. Since the Add2Exchange Service is stopped when you enter the Console, this is the 

first way to shut down the Add2Exchange Service.  

 

Click Yes. 

Once the service has started, you will see it in Task Manager, as well as a Red Sync icon on the bottom right 

hand side of the task bar shown below. 
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If you double click the red icon in the taskbar, a progress window will show what Add2Exchange is currently 

doing. This window will exit after a single module is done syncing. You must re open the window when it 

goes to the next module. 
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Sync Tip 
Whenever you exit the console and start the Add2Exchange Service, the Add2Exchange Service will 
automatically do a synchronization beginning 30-60 seconds afterward. It synchronizes GAL, Rel Manager. 
Calendars, Contacts, Tasks, Posts, and Notes separately in that order, starting with GAL 30-60 seconds after 
the Add2Exchange Service starts, then Rel Manager 30-60 seconds after GAL Sync completes, then 
Calendars 30-60 seconds after Rel Manager sync completes and so on.  
 
Add2Exchange then resumes the synchronization period manually specified in the Service Utility settings. 
Each time a module is synchronized (Calendars, Contacts or Tasks), you will see the Add2Exchange Agent 
program show up in the Task Manager. The Add2Exchange Agent is responsible for managing the 
synchronization process for each module and preventing conflicts from occurring with other instances of 
Add2Exchange should such an instance arise (this should not happen in normal operation). 
 
If no relationships are available to run, the Add2Exchange Agent simply exits. Allow a full synchronization 
cycle to occur across all modules and then check the results. If there are several thousand items and many 
relationships, the first time it synchronizes may take some time. 
 
The second synchronization takes significantly less time. Make sure no obvious duplication of Destination 
items is happening. It’s important to note that Add2Exchange will always sync in order. First it will sync the 
GAL into the GAL Cache Folder, then Relationship Group Manager, then Calendars, Contacts, Tasks, 
Notes, and Posts. You can also view the progress via Event Viewer. There will be a new log called 
Add2Exchange.  

 

These logs will specify the current situation as well as any error events or failures. When Add2Exchange is 

done syncing a particular module, you will have a success audit in the log that states it has finished that 

particular service.  

Here we can see that GAL Manager finished syncing into the GAL Cache Folder. 
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Note* Be patient for the first-time sync as it must create all relationships and sync all data for the first time. 

This may take some time depending on how much data we are syncing, and especially for Office 365 users. 

Opening up the Add2Exchange Console now will shut down the service automatically. Also, starting the 

Add2Exchange service while the console is open will result in no sync. 

Once you have success audits for all modules you are syncing with, then we know Add2Exchange has 

finished. You can now open the Add2Exchange Console to view all relationships Add2Exchange created. 
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If at any point in time you need to stop, start, restart the Add2Exchange service, you may do so in in Services. 

This is a controlled method of starting, stopping, or restarting the service handled by Add2Exchange.  

 

Note* If you have stopped or restarted the Add2Exchange service while it is in the middle of a sync, it will 

pause syncing for that particular module until the service is started again. Add2Exchange will then continue 

to sync were it left off when the service starts back up. 
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Licensing Add2Exchange 
To begin with, log into the Add2Exchange appliance as the Sync service account. From there, open the 

Add2Exchange Console.  

 

Once open, you will see the console below: 

 

On the tab pane, click License and then pick any module. In this case we will pick Calendar.  
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In this next window click on “View Registration Information” 

 

Fill out all the required information here and click on “Licensing what?” 

 

Highlight the licensed products you purchased and click “Add to My License Selection Below” When 

finished, click Done. 
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Finally, hit “Accept” to submit your license request. 

 

You will then see a window confirming your submission. 

 

Each module you are trying to license will have its own unique, different license key. Your license keys will be 

sent to both the email address you used for the End User License, as well as the sync service account email. 

Keys will be processed in the order they came in, and once received, simply open the Add2Exchange Console 

to automatically import the keys from the sync service account mailbox. Add2Exchange is now licensed.  
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Upgrading Add2Exchange 
Note* When upgrading Add2Exchange, ensure your software assurance subscription is still active. If you 

upgrade Add2Exchange to the latest build outside of your Software Assurance date, then Add2Exchange will 

not work any longer.  

To begin with, log into the Add2Exchange appliance as the Sync service account. Ensure that the 

Add2Exchange service is not running in services, and the Add2Exchange console is closed. If the 

Add2Exchange is still running, right click the service and choose Stop. 

 

Next, go into Control Panel > Programs and Features. 

Locate Add2Exchange, highlight and click Uninstall.  

 

 

Now it’s time to download the latest Add2Exchange upgrade. Go to Downloads, log in and download the 

latest Add2Exchange Upgrade software. Once downloaded, unpack the software by double clicking the self-

extracting executable. Open the unpacked folder contents and locate the file called 

“Add2Exchange_Upgrade.msi”. 

http://support.diditbetter.com/Secure/Login.aspx?returnurl=/downloads.aspx
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Double click “Add2Exchange_Upgrade.msi” to start the upgrade process.  

 
 

Click Next 

Click “I Agree” and Next 
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Click Next on the next 2 screens: 

 

 

Choose the installation path and click next.  

Note* We recommend defaults 
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Click Next when ready to continue: 

 

 

Add2Exchange will now ask for the Outlook profile used for the sync service account. Confirm the right 

Outlook profile and click Accept. 
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Now enter the Sync Service Account credentials. 

 

 

When finished, click Close. That’s it! Add2Exchange is now upgraded to the latest build. It is recommended 

you now open the Add2Exchange console to verify the upgrade. When finished, simply close the Console 

and start the Add2Exchange service.   
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Migrating Add2Exchange 
When migrating Add2Exchange to a new appliance, or migrating Exchange servers or to Office 365, the 

underlying process stays the same. We will begin by simply migrating Add2Exchange to a new appliance 

while on the same Exchange server.  

Migrating Add2Exchange Appliance only 
1. The first step is to upgrade Add2Exchange on the old box first prior to migrating. Upgrading 

Add2Exchange can be found HERE. 

Note* If you were previously running Add2Exchange on SQL 2005, then you must upgrade to SQL 

2008 or 2012 prior to migrating. 

2. Create a Folder on the root of C:\ and call is A2E Backup 

3. Open the Add2Exchange Console, click on Help and Export Setup. Save this file in the A2E Backup 

Folder.  

4. Open Regedit and drill down to: 

Computer\HKEY_LOCAL_MACHINE\SOFTWARE\WOW6432Node\OpenDoor 

Software®\Add2Exchange\Profile 1 

Right click Profile 1 and click Export. Save this file in the A2E Backup Folder.  

 
5. Next, ensure that the Add2Exchange service is not running in services, and the Add2Exchange 

Console is closed. If Add2Exchange is still running, right click the service and choose Stop. Also, 

stop the A2ESQLSERVICE found in services. 

 
6. Locate the Database Install path for Add2Exchange. By Default, it is located in:  

C:\Program Files (x86)\OpenDoor Software®\Add2Exchange\Database 

Copy the 2 Database files into the A2E Backup Folder.  

 
7. Backup is complete on the old box. Create a new folder on the new Add2Exchange box in the root 

of c:\ called zLibrary. Now we can take the A2E backup folder and move that folder to the zlibrary 

folder of the new appliance.  

8. Before installing on the new box, follow the instructions for installation found below 

• For Exchange 2010 Installation 

• For Exchange 2013-2016 Installation 

• For Office 365 Installation 
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Note* Since you are only moving Add2Exchange to a new appliance, you can use the same accounts to log 

in to the new box for installation and management. No need to create new sync service accounts or 

distribution lists.  

9. Now that Add2Exchange is installed on the new appliance, it is time to migrate the old database into 

the new install. ensure that the Add2Exchange service is not running in services, and the 

Add2Exchange console is closed. If Add2Exchange is still running, right click the service and choose 

Stop. Also, stop the A2ESQLSERVICE found in services. 

 
10. Locate the Database Install path for Add2Exchange. By Default, it is located in:  

C:\Program Files (x86)\OpenDoor Software®\Add2Exchange\Database 

 
11. Rename both files so that it looks something like below: 

New.A2E.mdf 

New.A2E_log.LDF 

12. Copy the old Database files from your A2E Backup and paste them into the new database location. 

By Default, it is located in: 

C:\Program Files (x86)\OpenDoor Software®\Add2Exchange\Database 

It should now look like this: 

 
13. Close Windows Explorer, go back into Services and Start the A2ESQLSERVICE 

 
14. Now open the Add2Exchange Console. If successful, you should see all of your old relationships still 

intact, but the software in now unlicensed.  

15. Relicense Add2Exchange. Show Me How   

16. Once everything is licensed and no other changes have been made with your Exchange or Office 365 

environment, then you should be able to start syncing right away.  

If you are having issues migrating Add2Exchange to a new appliance and would like us to help under 

Premier Support, open a support ticket online HERE.  

  

http://support.diditbetter.com/support-request.aspx
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Migrating Exchange Environments and Office 365 
Before we begin, it’s important to note a few items regarding Add2Exchange and migrating Exchange 

environments.  

• If migrating to Exchange 2010 from Exchange 2010, ensure that you first stop the Add2Exchange 

service prior to any migration of mailbox and public folders. This will ensure the integrity of the 

Add2Exchange database while migrating.  

• If migrating to Exchange 2013-2016, ensure that you first stop the Add2Exchange service prior to 

any migration of mailbox and public folders. This will ensure the integrity of the Add2Exchange 

database while migrating. In addition, if this will be a stepped migration were as some users will be 

on Exchange 2010 and others on Exchange 2013-2016, then ensure that you migrate the 

Add2Exchange account first.  

Note* If you are syncing public folders as well, then users on Exchange 2013-2016 must be able to 

see Public folders in Exchange 2010 via Outlook. If this is not enabled, then Add2Exchange will not 

work as intended.  

• If Add2Exchange is currently installed on the Exchange server, or an older appliance like Windows 

Server 2008, or Server 2008 R2, then it’s time to move Add2Exchange as well. Show Me How 

• If migrating to Office 365 and using third party tools such as SkyKick or MigrationWiz, you must 

remove all relationships from Add2Exchange prior to any mailbox or public folder migration. Show 

Me How 

• If all relationships and templates have been deleted prior to migrating for Office 365 users using 

SkyKick or MigrationWiz, and all data has been removed (Copied items). Then you are free to install 

fresh in your new Office 365 environment. Show Me How  

• If you have already migrated to Office 365 or any other Exchange environment without regard to 

Add2Exchange, STOP! Open a support ticket HERE so we may assess your options and how to 

safely move forward without creating duplicates when re connecting Add2Exchange.  

• If Add2Exchange was syncing to Exchange 2010-2013 using the legacy CDO (Collaborative Data 

Objects) protocol, and you are now moving to Exchange 2013-2016, or Office 365 without moving 

the Add2Exchange appliance, then we need to convert your installation to the newer methods using 

MAPI. This is done much easier if we just migrate the Add2Exchange install onto a new appliance. 

Show Me How 

• It is vital that your Autodiscover is setup correctly in order for the Add2Exchange Outlook profile to 

connect to the correct Exchange server or Office 365.  

In this example we will review a simple migration from Exchange 2010 to Exchange 2016 without 

moving Add2Exchange.  

1. To begin with, log into the Add2Exchange appliance as the Sync service account. Ensure that 

the Add2Exchange service is not running in services, and the Add2Exchange Console is closed. 

If the Add2Exchange is still running, right click the service and choose Stop.

 

http://support.diditbetter.com/support-request.aspx
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2. Upgrade Add2Exchange to the latest build. Show Me How 

3. If you are not using Outlook in conjunction with Add2Exchange, see HERE 

4. Migrate the Add2Exchange Mailbox to the new Exchange service 

5. When completed, make sure to open Outlook on the Add2Exchange appliance and ensure it is 

indeed connecting to Exchange 2016 rather than your old Exchange 2010. 

6. Make sure you can view public folders that may still be on your Exchange 2010 server if doing a 

stepped migration. 

7. Add Add2Exchange permissions to the new Exchange 2016 server. Show Me How 

8. Add Add2Exchange permissions to the old Exchange 2010 Server. Show Me How if doing a 

stepped migration. 

9. Open the Add2Exchange console. You might notice some relationships in alert. If so, you can 

right click an alerted relationship and click Relationship Report. If all permissions have been 

done already, a report should be generated in .txt format. This tells us that we do indeed have a 

proper connection to the old box and new.  

You should now be able to start the Add2Exchange service and start syncing again.  

Note* It is best practices to stop the Add2Exchange service from syncing when migrating users or public 

folders. Once the migration is done, re-run permissions and start the sync back. Do this until everyone and 

everything is migrated onto the new Exchange server.  

If you have any questions, concerns, or want us to handle your Add2Exchange migration under Premier 

Support, open a support ticket online HERE.  

  

http://support.diditbetter.com/support-request.aspx
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Troubleshooting Tips 
Something not syncing? Check the below table for issues and possible resolutions. You may also check 

HERE for tips and resolutions to almost any issue we have seen.  

Issue Possible Resolution 

Add2Exchange is not syncing at all - Ensure the Add2Exchange service is 
running. If not, start it up in Services, or 
restart if needed. 

- Was the Add2Exchange box logged off? If 
so, make sure the box is always logged in 
for continuous sync. 

Some users are getting the sync and some are not - Make sure your users have the proper 
Add2Exchange permissions. See Here 

- Ensure your users are added to the 
appropriate distribution list and are not 
hidden from the GAL 

Add2Exchange will not install successfully. An error 
about database tables not being created comes up 

- UAC (User Access Control) is not disabled. 
Please disable it through the registry, 
reboot, and try the install again 

I am not able to pick users from the GAL. It shows 
a blank folder picker 

- Make sure your users have the proper 
Add2Exchange permissions. See Here 

- Ensure your users are added to the 
appropriate distribution list and are not 
hidden from the GAL 

Slow Replication for Contact or GAL sync - You must disable the Outlook Social Client 
in Outlook. See HERE 

Relationships show that they are in alert - See Here 

Not all Calendar items are syncing / missing - See Here 

I migrated Exchange Servers or migrated to Office 
365 without regard to Add2Exchange 

- STOP! Open a support ticket HERE so we 
may assess your options and how to safely 
move forward without creating duplicates 
when re connecting Add2Exchange. 

The Add2Exchange Console will not open 
The Add2Exchange Service does not start 

- Check to ensure you have the proper 
credentials filled out in the service logon 
page 

- Do all Microsoft updates and reboot 
- UAC (User Access Control) is not disabled. 

Please disable it through the registry, 
reboot, and try again 

- Are you able to open Outlook on the 
Add2Exchange appliance using the 
Add2Exchange profile? If not, rebuild the 
Add2Exchange profile using the same 
name and ensure it is in On-Line mode. 
(Not Cached) 

- Ensure the A2ESQL Service is started as a 
local account 

I need support! - Open a support ticket online HERE.  
For remote/phone support, you will need a 
Premier Support plan. 

 

http://support.diditbetter.com/
http://support.diditbetter.com/disable-group-policy.aspx
http://guides.diditbetter.com/a2e-guide/index.html?relationship_alerts_and_unlicensed_relationships.htm
http://support.diditbetter.com/Forums/Thread.aspx?pageid=1&mid=2&ItemID=1&thread=190
http://support.diditbetter.com/support-request.aspx
http://support.diditbetter.com/support-request.aspx
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